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Naslovi radionica: 

UVOD...................................................strana 1
PHOTOSHOP......................................strana 3-17
ILLUSTRATOR...................................strana19-30
INDESIGN........................................strana 33-44
REZIME...................................................strana 45

Hello !

Vodič

Definicija Alatki

Bitno / Poželjno znati 

Ne zaboraviti potragu za novim resursima / 
linkovima / tutorijalima
napomena
> pre svake radionice, pre preporuke linkova -
budite upućeni u njihov sadržaj/deskripciju <

 Upotrebljeni simboli:

R1UVOD

Vremenski okvir i Metode:
Introdukcija 
	 Međusobno upoznavanje
	 Upoznavanje sa pravilima časova, domaćim zadacima; tehnička priprema+instaliranje
            Photoshop-a
	 Upoznavanje sa formom časova kao i formom programa
	 Icebreakers - ‘ Name Game ‘ - Igra upoznavanja 25min
Photoshop uvodna prezentacija + Photoshop or not - igra primera - 30 min
Konverzacija o očekivanjima 
           Očekivanja učesnika i multiplikatora//poželjno da učesnici naprave beleške o svojim
           očekivanjima od multiplikatora 
           Izlaganje  dizajnerskih radova
           KAHOOT quiz - 20min
Očekivano trajanje radionice: 75min

Ciljevi:
Uopšteni uvod, sveobuhvatni koncept rada/programa.
Podsticaj i motivacija

UVOD / KONCEPT 

https://dribbble.com/
https://www.behance.net/
https://www.instagram.com/?hl=en
https://www.pinterest.com/categories/design/
http://www.flatuicolorpicker.com/
https://color.adobe.com/create/color-wheel/
https://www.ronenbekerman.com/freebies/
http://www.thedieline.com/
http://prettycolors.tumblr.com/
http://www.freepik.com/
https://thenounproject.com/
https://www.lipsum.com/
http://slipsum.com/lite/
http://www.sleepyti.me/
http://radiooooo.com/

Inspirativni linkovi:
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R2
PHOTOSHOP 1 Naslovi radionica: 

Radionica 2
PHOTOSHOP 1: 
SELECTION TOOLS......................strana  3-4
CONTENT-AWARE MOVE TOOL.......strana 4

Radionica 3
PHOTOSHOP 2: 
PATCH TOOL..................................strana 5
HEALING BRUSH............................strana 5
STAMP TOOL.................................strana 5
BRUSH/FILL TOOL..........................strana 6

COLOR REPLACEMENT TOOL..........strana 6

Radionica 4
PHOTOSHOP 3: 
LAYERS - OBJAŠNJENJA.............strana 7-12
REFINE EDGE TOOL..................strana 10-11

LAYER MASKS............................strana12

Radionica 5
PHOTOSHOP 4: 
BLENDING MODES...................strana 13-14
ADJUSTMENT LAYERS..................strana 15

MOCKUPS................................strana 16-17

Timeframe & Methods:
Lekcija kroz teoriju i demonstraciju - 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični deo/vežbe učesnika - 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice: 95min

Ciljevi:
Uvod u osnove Photoshop-a, upoznavanje sa primenom alatki za 
selekcije, plus Content-aware move tool & metod;
Napraviti komparaciju među alatkama za selekciju

Upoznavanje sa:
- veoma značajnim osnovama Photoshop-a 
  (otvaranje, čuvanje, izvoz dokumenta)
- korisnim prečicama koje se najčešće primenjuju
- osnovnim alatkama (uopšteno; lokacija, primena) 

PREDAVANjE:

SELECTION TOOLS
CONTENT-AWARE MOVE TOOL

Selection Tools: 
Uz alatke iz palete Selection tools označavamo ona područja fotografije koja želimo 
da definišemo, odnosno menjamo na bilo koji način.
Selekciju je moguće napraviti uz pomoć Selection tool ili Selection command.
Moguće je menjati, kopirati ili brisati piksele unutar granica selekcije, ali ne i 
vršenje uticaja na prostor izvan tih granica sve dok se ne poništi označeno.
O Selection tools:
Selection tools pripadaju paleti alatki, smeštenoj na levoj strani vašeg ekrana.
Rectangular Marquee Tool - granice selekcije kvadratnog ili pravougaonog oblika.
Elliptical Marquee Tool - granice selekcije kružnog ili elipsastog oblika.
Lasso Tool - slobodoručne granice selekcije (uglavnom najpreciznije).
Polygonal Lasso Tool - višebrojni pravolinijski segmenti granice selekcije.
Magnetical Lasso Tool - granice selekcije koje automatski prepoznaju (‘hvataju’) ivice 
kada prevučete mišem preko fotografije.

Magical Wand Tool 
Selektuje piksele sličnih boja jednim klikom.
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W2
PHOTOSHOP 1 

Linkovi:

R3
Vremenski okvir i Metode:
Pregled domaćih zadataka - 15min
Lekcija kroz teoriju i demonstraciju - 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični deo/Vežbe učesnika - 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice: 110min

Ciljevi:
Upoznavanje sa primenom Retouching alatki / demonstracija
Dodatno istaći Paint Bucket Tool (sa tri načina menjanja boja)

PREDAVANjE:

PHOTOSHOP 3 

Ne zaboraviti potragu za novim resursima i linkovima za teme ovog časa!

PATCH TOOL, HEALING BRUSH, 
STAMP TOOL, BRUSH&FILL TOOLS,
COLOR REPLACEMENT TOOL

Patch Tool
Patch Tool je deo Healing Brush seta alatki, i smeštena je ispod alatke Spot 
je odmah ispod alatke Healing Brush Tool. 
Pretežno se primenjuje pri retuširanju i prepavci 
fotografija, u vidu pravljenja tzv. zakrpa željenog 
dela slike.
Vrlo je korisna alatka ukoliko želite da je primenjujete 
za prepravku većih područja.
Healing brush/ Stamp Tool:
Spot healing brush je uobičajena ‘healing’ alatka u 
Photoshop-u, može se koristiti za kloniranje područja 
slike i blendiranje piksela uzorka sa pikselima ciljanog 
područja. Drugačije rečeno, ove alatke koriste uzorke 
obližnjih područja kako bi prepravile ciljano područje. 
Stamp tool je prilično slična alatka, ali je bazirana na 
principu pečata/žiga, odnosno, selektovano područje 
možete upotrebiti kao uzorak za vaš pečat.

SELECTION TOOLS
CONTENT-AWARE MOVE TOOL

O Selection tools:
Quick Selection Tools - Pri kliku na željeno područje, brzo i 
automatski pravi selekciju sličnih delova slike, baziranu na boji i teksturi.

Select  Brush Tools - automatski selektuje, odnosno
de-selektuje  područje koje bojite,
u zavisnosti od toga da li ste na 
Selection ili Mask mode.

Smart Brush Tool - primena boja,
prilagođavanje nijansi i efekata na selektovano.
Navedena alatka automatski kreira 
Adjustment layer (lejer podešavanja)
za nepromenjeni prikaz.

Content-Aware Move:
Content-Aware Move Tool primenjuje se za selekciju i pomeranje dela slike. 
Kompozicija slike je izmenjena, a preostali prazan prostor popunjen je 
odgovarajućim/podudarnim elementima slike. 

U paleti alatki, dugi klik na Spot Healing Brush 

Primeniti Move mode kako bi se selektovani objekti premestili na drugu lokaciju. 
Primeniti Extend mode kako bi se objekti proširili ili smanjili.

i selektovati Content-Aware Move Tool
u panelu za opcije, uraditi sledeće:

Content-Aware Move opcije

https://www.youtube.com/watch?v=zgi74GhtJk4
https://www.youtube.com/watch?v=DCJjEA4WrOc
https://cdn.makeawebsitehub.com/wp-content/uploads/2015/04/
photoshop-a4-keyboard-shortcuts-print-pdf.pdf
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PHOTOSHOP 2 

Ne zaboraviti potragu za resursima i linkovima na temu časa!

Linkovi:

R4LAYERS - OBJAŠNJENJA
REFINE EDGE TOOL, LAYER MASKS

Vremenski okvir i Metode::
Pregled domaćeg zadatka- 15min
Lekcija kroz teoriju i demonstraciju - 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični deo/Vežbe učesnika - 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice: 110min

Ciljevi:
Upoznavanje sa Lejerima, demonstracija primene Refine edge tool, 
obrazloženje Lejer maski.

PREDAVANjE:

Jedna od najbitnijih stvari u Photoshop-u jesu Layers(lejeri, slojevi). 
Zamislite ih kao prazne listove papira, 
koje možete slagati jedne na druge.

Recimo da želimo da na fotografiju polja, dodamo sliku kuće i 
psa. 
Polje bi nam bilo poput osnovne fotografije, one koju želimo  
da zadržimo u postojećem stanju. Upravo ta slika polja bila bi 
nam Background layer - onaj na koji dodajemo različite 
‘listove papira’, odnosno lejere/slojeve novih slika(konkretno 
u ovom primeru - kuća, pas).

Smeštajući sliku kuće i sliku psa u nove lejere, možemo ih 
pomerati nezavisno/zasebno, brisati ih, editovati, ili šta god 
drugo imamo za cilj, i, pritom se Background layer ne menja
(slika polja). Pokušajmo!

PHOTOSHOP 3 

W3 PATCH TOOL, HEALING BRUSH, 
STAMP TOOL, BRUSH&FILL TOOLS

Brush i Fill Tool:
Fill tool (popunjavanje) omogućuje vam menjanje boje selektovanog pod-
ručja. Možete ih pronaći na Gradient Tool ili prosto primeniti prečicu Alt+f.
Kako biste koristili Fill Tool, selektujte(označite) područje, označite 
željenu boju, i potom jednostavno kliknite na 
vaše označeno područje. 

https://www.youtube.com/watch?v=YNg1sqsQhoI
http://tricky-photoshop.com/healing-brush-tool-in-photoshop/
https://www.youtube.com/watch?v=82GH2H7l4DQ

Color Replacement Tool:

Kada želite da promenite boju nekog objekta, a da 
pritom ne menjate njegove prvobitne karakteristike  
(teksturu i sl.), koristite ovu alatku.

(primer među linkovima ispod)
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PHOTOSHOP 3 Otvorimo novi dokument (sliku polja), 
potom  kliknemo na  tab   window/ layers. 
Ukoliko je označen, trebalo bi da se pojavi na desnoj strani 
ekrana. Možete videti samo jedan lejer, sliku polja. 

Klikom na Lock icon, ikonicu lokota(katanca) - smeštenoj iznad kartice lejera - omogućavamo 
ili onemogućavamo prikaz slike, npr. ukoliko je slika zaključana, ne može se editovati. 
Kako bismo dodali novi lejer, kliknućemo na malu ikonu na kartici lejera/ili Layer>New Layer. 
Označeni lejer je transparentni ‘list papira’, možete videti desno - označeni lejer je aktivan .

LAYERS - OBJAŠNJENJA
REFINE EDGE TOOL, LAYER MASKS

Označeni lejer

Ikonica vidljivosti  -  Eye Icon

Zaključani Background

Dodaćemo sliku kuće i sliku psa  u dva odvojena lejera. 
Više lejera je uvek bolji izbor !
Pokazaćemo vam kako ih možete spojiti u jedan lejer, ili ih grupisati. 

Ukoliko vam lejeri nisu potrebni i želite da ih izbrišete, dugim levim klikom miša, 
možete ih prevući i ‘spustiti’ na ikonicu kante za otpatke (Trash Can) smeštenoj na 
dnu kartice za lejere.
Promenom naziva vaših lejera pospešujete njihovu organizovanost, 
što je jednostavno učiniti - duplim klikom na njih.

R4LAYERS - OBJAŠNJENJA
REFINE EDGE TOOL, LAYER MASKS

Nešto što je usko povezano sa lejerima jeste:
Adjustment palett(Paleta za prilagođavanje) - smeštena upravo 
iznad kartice lejera. 
Primenom ove palete podešavanja, možemo 
menjati stil našeg lejera, poput 
Contrast, Saturation, Hue, Color Balance... ,
i na taj način učiniti da naše slike izgledaju 
bolje, svetlije ili tamnije, da im damo
dubinu, ili, uostalom, šta god mi želimo.

Da ponovimo, lejeri su dodati i zato
ne moramo 
trajno menjati karakteristike slike,
ali dodavanjem ovih promena u stilu lejera,
trajno menjamo sam stil lejera.

Clipping Masks(isečak): 
Služimo se Maskama, koje su poput lejera, i koje mogu izolovati deo slike 
a sačuvati je od trajne promene. Upravo kao što tipične maske to čine. 
Maskirajmo samo neke delove slike, kako bismo mogli menjati određeni deo slike ili 
ga zaštititi od izmena. Postoji mnogo tipova maski u Photoshop-u.

Nastojaćemo da koristimo najjednostavniji način primene maske. 
Imamo Background fotografiju, počnimo sa upotrebom maske. 
Na Background lejeru koristite koju god alatku za selektovanje želite:
Lasso, Rectangle, Ellipse... Pri označavanju dela fotografije, možete videti da se oko 
njega pojavjuju tanke linije, sa uglovima koji blago trepere. 
Sada možete da napravite masku !

PHOTOSHOP 3 

W4
Ikonica malog oka do lejera predstavlja njegovu vidljivost, i klikom na nju videćete da 
funkcioniše principom ON/OFF. f.
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PHOTOSHOP 3 

Ovaj deo slike je izolovan od celine. Proverimo.
Primenimo Paintbrush tool kako bismo obojili selektovani deo.

Okej, pogledajmo - primenjena boja ne prelazi granice označenog područja. Ali, ukoliko 
vam ne odgovaraju promene, možete ih obrisati upotrebom tipke Delete na tastaturi.
Na primer, upravo sada primenjujemo masku na Background layer, bez dodavanja
transparentnog/prozirnog ‘papira’ između, pa sada imamo prazan prostor na našem 
polju. Zato su lejeri veoma bitni. Vratimo se na nepromenjenu sliku.

LAYERS - OBJAŠNJENJA
REFINE EDGE TOOL, LAYER MASKS R4Vežbajmo sada na ovaj način: Napravite novi, transparentni lejer, 

preko Background lejera. Selektujte nešto i napravite masku. 
Pokušajte ponovo, sa upotrebom Paintbrush alatke, i možete videti 
da je željeni deo izolovan. Zatim probajte da ga izbrišete, videćete da 
ste uspeli. Bravo!
Drugi način: Pravljenjem Pixel Mask Tool. 
Za početak možete koristiti Selection Tools i Brushes (paletu četkica) za bojenje maske  koju
kreirate. Selektujte uz pomoć ovih alatki, potom kliknite na ikonicu Add layer mask 
smeštenoj pri dnu kartice za lejere. 
U opciji Foreground color, kada je maska označena, pojavljuju se samo crna i bela boja. 
Foreground color paleta prikazana je u vidu dva mala kvadrata sa leve strane - pri dnu 
monitora, koji mogu biti različitih boja. 
Crna boja koristi se za skrivanje selektovanih delova maske, dok se bela boja koristi za 
njihovo otkrivanje. 
Društvo, pokušajte, isprobajte... nije komplikovano!

Kako bismo uvežbali, hajde da napravimo masku ovog lepog psa gore prikazanog. Možete 
uočiti da bi bilo pogodno da se njegovo krzno malo niveliše/poravna, zato ćemo doraditi 
ivice maske. 
Upravo ovo činimo uz pomoć Refine Edge (prečice Alt+Ctrl+R za Windows,
 a za Mac Opt+Cmd+R)

De-selektujte sve(poništite celu selekciju). Pritisnite CTRL tipku na tastaturi i kliknite 
na umanjeni prikaz maske. Među panelima pri vrhu, kliknite na Refine Edge.

LAYERS - OBJAŠNJENJA
REFINE EDGE TOOL, LAYER MASKS

PHOTOSHOP 3 

W4
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PHOTOSHOP 3 

https://www.youtube.com/watch?v=jI-9Mr7cLBY

Linkovi:

Ovde postoji više opcija koje su nam na raspolaganju. Sliders (rulere) , možete 
pomerati i primetiti šta čini bolju, efikasniju prepravku ivica - Refining the edges.
Isprobajte View mode, da biste videli kako funkcioniše (odaberite ga u padajućem 
meniju-Drop down menu). 
Takođe, istražujte primenjujući Feather Slider, Smooth i Contrast.

LAYERS - OBJAŠNJENJA
REFINE EDGE TOOL, LAYER MASKS R5BLENDING MODES, 

ADJUSTMENT LAYERS, MOCKUPS

Vremenski okvir i Metode:
Pregled domaćih zadataka- 15min
Lekcija kroz teoriju i demonstraciju - 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični deo/Vežbe učesnika - 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice: 110min

Ciljevi:
Upoznavanje sa lejerima/slojevima i demonstracija Blending opcija, 
Adjustment lejeri, ukazivanje na značaj Mockup-a/njegovo kreiranje
Poželjno je napraviti trening-zadatak za primenu Blending opcija i 
Adjustment lejera

PREDAVANjE:

Blending modes: 
Blending opcije pružaju kontrolu načina mešanja(spajanja) boja piksela svakog 
lejera zasebno i slike koju možete videti na pregledu lejera(panel lejera). Svaka-
ko, poželjno je da ovo činite u lejerima, ukoliko ne želite da pravite promene koje 
mogu dovesti do oštećenja vaše slike. 
Kada otvorite Blending Modes padajući meni, koji se nalazi pri vrhu panela lejera, 
primetićete višebrojne opcije sortirane po grupama:
Normal modes
Normal 
Darken modes - potamnjivanje slike
Multiply - Darken Color- burnLinear- burnDark color
Lighten modes - posvetljivanje slike
Lighten - screen - Colordodge - Lineardodge - Lighter color
Contrast modes - for making contrast
Overlay - Hard light - Soft light - Linear light - Pin mix
Comparative modes - poređenja (sličnosti/razlike)
Diference- Exclusion - Subtrcact - Divide
Composite modes - mešanje nijansi, saturacije(zasićenja), osvetljenja - 
 sa osnovnom bojom
Hue - Saturation - Color - luminosity

PHOTOSHOP 4 

W4

Ne zaboraviti potragu za resursima i linkovima na temu radionice !



14 15

PHOTOSHOP 4 

BLENDING MODES, 
ADJUSTMENT LAYERS, MOCKUPS R5BLENDING MODES, 

ADJUSTMENT LAYERS, MOCKUPS

Adjustment Layer: 
Adjustment(regulisanje/podešavanje) layer je lejer 
koji omogućuje primenu boja,
 i tonalno(ravnomerno/nijansirano) regulisanje 
vaše slike, bez promene kvaliteta piksela. 
Možete koristiti Adjustment layer kako biste
eksperimentisali sa nijansama boja i videli njihov 
uticaj na vašu sliku 
Pokušajte da Adjustment layer zamislite kao 
prozirni veo/zavesu kroz koju je moguće videti lejere 
smeštene pod njom. 
Kreiranje Adjustment lejera: 
Selektovati onaj lejer koji 
želite da korigujete, kliknuti na njega-kreiranje New Adjustment layer,
odaberite Adjustment i potom klik na OK. OK. 

PHOTOSHOP 4 

W5
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PHOTOSHOP 4 

BLENDING MODES, 
ADJUSTMENT LAYERS, MOCKUPS

Mock-Up:
U grafičkom dizajnu, Mockup(mokap), ili Mock-up, je model(skalirani ili u punoj 
veličini) dizajna ili objekta/uređaja/predmeta, koji se koristi za demonstracije, 
promocije, prezentacije... i za slične svrhe. Pretežno, dizajneri ih koriste kako bi 
dobili realniju povratnu informaciju od strane korisnika. 
U praktičnom smislu, oni predstavljaju objekte, na koje možete postaviti svoj dizajn 
u cilju dobijanja realističnijeg utiska o tome kako bi vaš rad izgledao.

Prvobitno otvoriti novi dokument- New Document. 
Kliknite na /File - Place - Choose/ odaberite sliku sa vašeg računara (otvorite je).
Podesite Mockup- sliku na vašem ’umetničkom platnu/prostoru’  koristeći  
Shift na tastaturi.

R5

https://99designs.com/blog/design-tutorials/how-to-use-adobes-adjustment-layers-photoshop-cs6/

Linkovi:

File - Place - Choose / odabrati sliku dizajna sa računara (otvoriti je) 
Transformisati sliku koristeći CTRL, komandu, kako bi sa preciznošću uklopili sliku u ekran. 

Podesite rulere unutar prostora u kome želite da smestite vaš dizajn.

PHOTOSHOP 4 

W5

Ne zaboraviti potragu za novim resursima i linkovima za ovaj čas !

https://www.mockupworld.co/all-mockups/             
https://www.behance.net/free-psd-templates 
https://freedesignresources.net/category/free-mockups/

Linkovi:
                                      POSEBNU PAŽNjU 
                         usmeriti na preuzimanje 
                Mockup-a / pojasniti, ispratiti
              NOVI LINKOVI SU DOBRODOŠLI
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Naslovi radionica: 

Rdaionica 6
ILLUSTRATOR 1: 
RECTANGLE TOOL.......................strana 19-20
ELIPSE TOOL...............................strana 19-20
FILL/GRADIENT TOOL.................strana 21-22
STROKE......................................strana 21-22
ALIGN OPTIONS.............................strana 22

Radionica 7
ILLUSTRATOR 2: 
SHAPE BUILDER TOOLS..............strana 23-24
PATHFINDER - OPTIONS.................strana24
DIRECT SELECTION TOOL
(MOVING ANCHOR POINTS)...........strana 25
           

Radionica 9
ILLUSTRATOR 4: 
TRACING IMAGES.......................strana 29-30

Radionica 8
ILLUSTRATOR 3: 
PEN TOOL......................................strana 27
BRUSH TOOL (WITH LIBRARIES)..strana 27-28
WORKING WITH
TYPOGRAPHY.................................strana 28

R6RECTANGLE TOOL, ELIPSE TOOL, 
FILL/GRADIENT TOOL & STROKE, 
ALIGN OPTIONS

Vremenski okvir i Metode:
Pregled domaćih zadataka - 15min
Illustrator uvertira - 10min
Lekcija kroz teoriju i demonstracija- 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični deo/Vežbe učesnika- 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice:  110min

Ciljevi:
Uvod u Illustrator - Prvobitno Interface programa
paralele Illustrator - Photoshop
Primena alatki i opcija - Shape tools, Fill and Stroke, 
Align options

PREDAVANjE:

Pri otvaranju Illustrator-a, Tools paneli pojaviće se sa leve 
strane ekrana. Alatke iz Tools panela primenjujete za 
kreiranje, selekciju, kao i manipulaciju objekata u 
Illustrator-u. Opcije nekih alatki pojavljuju se 
duplim klikom na njih. U ove alatke svrstavaju se one koje 
omogućuju selekciju, pisanje, bojenje, crtanje, upotrebu 
uzoraka, prikazivanje, pomeranje slika (select, type, paint, 
draw, sample, edit, move images) Za prikaz naziva alatke, 
strelicu miša centrirajte preko ikonice alatke.

The Rectangle tool  
 M
kvadrati i 
pravougaonici.

The Rounded

kvadrati i 
pravougaonici  
zaobljenih uglova

The Ellipse tool  
  L 
krugovi, elipse
ovalni objekti

ILLUSTRATOR 1 
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ILLUSTRATOR 1 

RECTANGLE TOOL, ELIPSE TOOL, 
FILL/GRADIENT TOOL & STROKE, 
ALIGN OPTIONS

Crtanje pravougaonika i kvadrata: 
Selektovati Rectangle tool        ili Rounded Rectangle tool         
Za crtanje pravougaonika, vući dijagonalno dok pravougaonik nije željene veličine.
Za crtanje kvadrata, držati Shift, vući dijagonalno dok kvadrat nije željene veličine.
Za kreiranje pravougaonika ili kvadrata određenih dimenzija, kliknite tamo gde želite 
da bude levi ugao. Odredite širinu i visinu (kao i ugao radijusa za zaobljene uglove), 
kada unesete vrednosti, klik na OK.

Crtanje ovalnih oblika: 
Duži klik na Rectangle tool      . Selektovati  Ellipse tool  

Uraditi sledeće:
Vući dijagonalno dok elipsasti objekat nije 
željene veličine.
Kliknuti tamo gde želite da se nalazi gornji levi ugao 
graničnog okvira elipse. Odrediti širinu 
i visinu elipse, potom klik na OK.
Za kreiranje kruga, dugi klik na   Shift     dok vučete mišem. 
Da odredite dimenzije, unesite vrednost za širinu, kliknite 
na Height i kopirajte unešenu vrednost širine u sanduče za 
visinu - Height box. 

R6RECTANGLE TOOL, ELIPSE TOOL, 
FILL/GRADIENT TOOL  i  STROKE, 
ALIGN OPTIONS

Illustrator pruža dve metode crtanja/’slikanja’:
Dodavanjem linija objektu(stroke), popunjavanjem objekta(fill), ili 
kombinacija fill i stroke.
Konvertovanjem objekta u Live Paint Group i popunjavanjem objekta/dodavanjem linija 
zasebnim ivicama i Faces of paths unutar njih.
Trenutne boje fill i stroke opcija, pojavljuju se među Tools panel.

Fill i Stroke Podešavanja:
Konfiguracija ovih podešavanja može se obaviti koristeći  
Tools panel, Control panel,  i Color panel.
Upravljati nekim od sledećih kontrola iz Tools panela za određivanje boje:

Primenom dole navedenih opcija iz Control panel-a, takođe se mogu podešavati boje, 
linije:
Fill color:
Klik za otvaranje  Swatches panel ili  Shift-klik  za otvaranje panela alternativnih boja, 
potom izabrati boju.
Stroke color
Klik za otvaranje  Swatches panel ili  Shift-klik  za otvaranje panela  alternativnih boja, 
potom izabrati boju.
Stroke panel
Klik na Stroke za otvaranje Stroke panel, odabrati opciju.
Selektovati objekat upotrebom Selection Tool      ili  Direct Selection Tool    .
Klik na Fill box u Tools panel ili na Color panel kako biste dali komandu da biste  radije 
odabrali fill nego stroke

Fill button:       Dupli klik za odabir boje za popunjavanje uz pomoć Color Picker.
Stroke button:      Dupli klik za odabir boje za linije uz pomoć Color Picker.
Swap Fill   i    Stroke button:      Klik za zamenu boja između fill i stroke.
Default Fill    i    Stroke button:      Klik na vraćanje prvobitnih podešavanja boje 
                                                             (fill bele boje i stroke crne boje).
Color button:  v Klik za dodavanje poslednje selektovane boje objektu uz pomoć 
                              Gradient fill ili No stroke ili fill.
Gradient button:      Klik za promenu sa trenutno odabranog fill na poslednje
                                     selektovani gradient.
None button:      Klik za uklanjanje odabranog  fill  ili  stroke.

ILLUSTRATOR 1 
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ILLUSTRATOR 1 
Selektovani Fill Box. Fill box nalazi se iznad Stroke box. 

Odabrati Fill color prateći sledeće:
Klik na boju u Control Panel, Color Panel, Swatches Panel, Gradient Panel, ili Swatch Library.
Dupli-klik na Fill box i odabir boje na Color Picker.
Selektovati Eyedropper tool i Alt + klik (Windows) ili Option + klik (Mac OS) 
objekat za primenu trenutnih atributa, uključujući trenutni Fill i Stroke.
Klik na None button      za uklanjanje trenutnog odabira Fill.
Takođe, ikonicu None možete pronaći u Fill-meniju ili meniju Stroke Color među 
Control panelu.

RECTANGLE TOOL, ELIPSE TOOL, 
FILL/GRADIENT TOOL i STROKE, 
ALIGN OPTIONS

Fill i Stroke boxes: 
A. Fill box B. Stroke box C. None button  
Selektujte objekte sa istim odabirom za Fill i Stroke 
Možete selektovati objekte koji imaju iste atribute, 
poput fill color, stroke color, i stroke weight.

Align i Distribute objects:
Koristite Align panel (Window > Align) i Align opcije na Control panelu kako biste napavili 
celinu ili odredli prostor među označenim objektima prateći osu/putanju koju ste definisali. 
Za referentne tačke možete koristiti uglove objekata ili Anchor points (fiksne tačke), i možete 
izvršiti poravnanje osa prema selekciji, prema vašem Artboard-u, ili prema 
ključnom objektu. Upravo ključni objekat jeste jedan specifični/određeni objekat u selekciji 
višebrojnih objekata.
Align options prikazane su na Control panel onda kada je objekat selektovan. Međutim, 
ukoliko se ne prikazuju, potrebno je odabrati Align iz Control panel menija.

Selekcija objekata za primenu opcija Align ili Distribute:
Na Align panelu ili Control panelu, selektovati Align To 
Selection        , potom kliknuti za unos 
željenog poravnanja ose, odnosom medju objektima.
Ukoliko koristite Anchor point kao referentnu tačku: 
Klik na Direct-Selection Tool, držeći stisnutim Shift 
označite Anchor tačku na koju želite da primenite Align 
ili Distribute. Poslednja Anchor tačka koju ste selektovali 
postaje ključna Anchor tačka.

R7SHAPE BUILDER TOOLS, PATHFINDER 
(OPTIONS), DIRECT SELECTION TOOL 
(MOVING ANCHOR POINTS)

Vremenski okvir i Metode:
Pregled domaćih zadataka - 15min
Predavanje i demonstracija(Alatke za retuširanje)- 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični deo/Vežbe učesnika - 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice: 110min

Ciljevi:
Teorijsko upoznavanje sa navedenim alatkama, opcijama, 
demonstracija njihove primene
Shape Builder Tool, Pathfinder, Direct Selection Tool;
Napraviti komparaciju među alatkama za selekciju

PREDAVANjE:

Shape Builder Tool:
Primenom Shape builder alatke, možete 
combinovati, prikazivati i popunjavati ob-
jekte na vašem umetničkom ‘platnu’ - na
‘artboard’. 
Prvi korak jeste kreiranje nekog oblika, na 
primer, zvezde ( ili više njih). Potom klik na 
Selection Tool da biste pomerili objekte 
tamo gde želite, kombinovali ih ili slično. 
Naredni korak jeste bojenje - samo klikom 
na Fill možete odabrati boju i tako obojiti 
željeni oblik/objekat. Takođe, ako želite da 
primenite odabranu boju samo na liniju, 
opcija se nalazi odmah do Fill - Fill a stroke. 
Ukoliko želite menjati širinu linije, klik na 
Stroke weight 
(smeštena na gornjoj paleti opcija).

ILLUSTRATOR 2 
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Ne zaboraviti potragu za 
resursima i linkovima !
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ILLUSTRATOR 2 

SHAPE BUILDER TOOLS, PATHFINDER 
(OPTIONS), DIRECT SELECTION TOOL 
(MOVING ANCHOR POINTS)

               Pathfinder:
Pathfinder alatka omogućava najbrži način 
manipulacije putanjama i oblicima (deliti/spajati 
objekte/oblike, i tome slično). 
Pathfinder  pronaći ćete  klikom na Window 
meni, kao i Shape modes  uz pomoć kojih je 
moguće spojiti više oblika u celinu, ukloniti neke 
i sl.
Možete kombinovati višebrojne objekte i 
odrediti u kakvom će odnosu svaki od njih biti sa 
drugim objektima (odrediti njihovu interakciju). 
Kao prvi korak, napravite bilo koja dva oblika 
(primer-pravougaonik i zvezdu). Kombinovaćemo 
putanje (Paths) dva obilka kako bismo napravili 
jednu/zajedničku putanju. 

1. 2. 3.

R7SHAPE BUILDER TOOLS, PATHFINDER 
(OPTIONS), DIRECT SELECTION TOOL 
(MOVING ANCHOR POINTS)

               Direct Selection Tool:
Direct selection tool omogućuje selekciju i 
modifikovanje putanje unutar oblika. Ovom 
alatkom može se označiti jedna/individualna 
Anchor point ili cela putanja. Ukoliko kliknete 
na jedan deo, nećete selektovati celu grupu 
objekata/oblika. 
Potrebno je dugim klikom povlačiti kako 
bismo mogli da pomeramo objekte. Krug sa 
slike primera desno, u svom okviru sadrži 
četiri mala kvadrata plave boje. Upravo oni 
predstavljaju tzv.fiksne tačke - Anchor points. 
Držeći klik na njih, možete da ih pomerate. 
Neophodno je pomenuti Direction points, 
uz čiju primenu možete izvršiti promene 
oblika, pravca..

https://www.youtube.com/watch?v=WPP7Nh_waNs

Linkovi:

1. 2.

ILLUSTRATOR 2 
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Ne zaboraviti potragu resursa i linkova za ovaj čas!

/napomena/
Za vežbanje rada sa Pathfinder alatkom 
napraviti zaseban zadatak/vežbu.
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R8 PEN TOOL, 
 BRUSH TOOL (WITH LIBRARIES),
 WORKING WITH TYPOGRAPHY

Vremenski okvir i Metode:
Pregled domaćih zadataka- 15min
Uvid u lekciju i demonstracija primene navedenih alatki - 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični rad učesnika/Vežbe - 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice: 110min

Ciljevi:
Uvesti i razraditi temu radionice
Alatke Pen tool, Brush tool(sa datotekom)
Working with Typography - Tipografija + demonstracija uvoza novih fontova

PREDAVANjE:
Pen Tool:
Pen tool je alatka koja se u Illustrator-u najčešće primenjuje a ujedno predstavlja i 
najmoćniju alatku. 
Omogućuje vam određivanje vaših Anchor points(fiksnih tački), 
ali i  prilagođavanje k r i v e. 
Podkategorije ove alatke: Adding anchor points (dodavanje), Deleting anchor 
points(brisanje/oduzimanje).
Kada zadržite klik na ctrl, selektujete i crtate/pomerate Anchor, možete napraviti 
oblik koji želite. (korisna igra za vežbu - Bezier game online)

Brush Tool:
Brush tool je alatka koja se primenjuje istim principom kao i u Photoshop-u, 
(odaberete boju i pomerate četkicu kako biste bojili), ali u Illustrator-u prisutno je 
više opcija koje se odnose na četkicu, poput više modela i tipova četkice.

ILLUSTRATOR 3 

^
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ILLUSTRATOR 3 

PEN TOOL, 
BRUSH TOOL (SA DATOTEKOM),
TIPOGRAFIJA

Brush Library:
Kao što možete zaključiti prema fotografiji, postoji mnogo 
tipova četkica u Illustrator-u.

Type Tool:
Selektujte Type Tool, podesite okvir za 
pisanje tamo gde želite, i počnite sa 
unosom teksta. Možete korigovati veličinu 
svakog slova zasebno, prostor između njih, 
smer teksta... 
Takođe, možete menjati raspored slova, 
pisati po 
željenim oblicima (Type on a Path Tool)..

http://bezier.method.ac
https://www.1001freefonts.com/  - pojasniti instalaciju novih fontova

Linkovi:

R9TRACING IMAGES

Vremenski okvir i Metode:
Pregled domaćih zadataka - 15min
Predavanje i rad sa navedenom alatkom - 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični rad učesnika/Vežbe - 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice: 110min

Ciljevi:
Teorijski i praktični pristup  >> metode i opcije, alatke 
Tracing images (nacrt fotografija-konture-precrtavanje)
Osvrt na prethodnu radionicu, porediti i nadovezati se

PREDAVANjE:

Tracing Tools:
Live Trace alatka Adobe Illustrator-a dizajnirana je tako da menja vaše Bitmap slike/
dokumenta u Vektorske crteže. Najveća prednost vektorskih slika jeste to što se 
njihova veličina može menjati bez gubitka kvaliteta. 

Ova alatka sadrži mnogo opcija (Tracing options) koje možete primenjivati i videti 
kakve promene/rezultate pruža !

ILLUSTRATOR 3 
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Ne zaboraviti potragu za resursima i linkovima !



30

ILLUSTRATOR 4 

TRACING IMAGES

Pre i Nakon primene Live Trace komande na Bitmap sliku.

https://www.youtube.com/watch?v=oIaNSI_J36Q
https://www.youtube.com/watch?v=tGfdd037kQM&t=341s
https://www.youtube.com/watch?v=RdfPy6j6TRM&t=77s
https://www.youtube.com/watch?v=6c_aoAjhcB8

Linkovi:

*Live a Less Electrical Life  by Hudson-Powell  

W9

Ne zaboravite potragu za resursima i linkovima !
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Naslovi radionica: 

Radionica 10
INDESIGN 1: 
CREATING MULTI-PAGE 
DOCUMENT..............................strana 33-34
BLEED ADJUSTMENT.................strana 35-36
MASTER PAGE - OBJAŠNJENJA..........strana 34

Radionica 11
INDESIGN 2: 
WORKING WITH IMAGES 
AND TEXT BOXES.......................strana 37-38
IMPORTING DATA
FROM ILLUSTRATOR.......................strana39

Radionica 12
INDESIGN 3: 
PAGE NUMERATION..................strana 41-42
MULTI-MASTER PAGES..............strana 43-44
EXPORTING DATA..........................strana 44

Radionica 13
REZIME CELOG PROGRAMA
I PONAVLJANJE
PROPUŠTENIH TRENINGA..............strana 45

R10CREATING MULTI-PAGE DOCUMENT, 
BLEED ADJUSTMENT, 
MASTER PAGE - OBJAŠNJENJA

Vremenski okvir i Metode:
Pregled domaćih zadataka- 15min
Predavanje i demonstracija - 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični rad učesnika/Vežbe - 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice: 110min

Ciljevi:
Uvod u osnove InDesign-a - Prvobitno Interface programa
Paralele/komparacija programa (Photoshop, Illustrator). 
Demonstracija-kreiranje dokumenta sastavljenog od više strana, 
podešavanja Bleed-a(bezbednog prostora)
Predavanje i značaj Master Page.

PREDAVANjE:

KREIRANjE MULTIPAGE DOCUMENT (višestranog dokumenta):
Prvi korak koji ćete napraviti u vašem procesu rada jeste pravljenje poglavlja/
zaglavlja vašeg prvog-osnovnog pisma. 
Format ovo dokumenta je klasični A4 format. 
Otvoriti InDesign i odabrati  File > New Document kako biste napravili novi 
dokument. 
Podesiti Intent za Print i Number of Pages na 1 (kasnije dodajemo više strana). 
De-selektovati Facing Pages. Pod Page Size odabrati A4. 

Postaviti Bleed na .125 na sve četiri strane.

Za početak, dizajniraćemo  prednju stranu koverte, zato  dodajemo samo jednu stranicu. 
Udvostručite stranicu koju ste upravo napravili klikom i povlačenjem stranice iz Pages panel 
do New Page ikonice - smeštenoj sa leve strane ikonice Kantice za otpatke.

Kada se uverite u to da je druga stranica aktivna na Pages panel , selektujte Page Tool. 
Primetićete da je stranica označena novim fiksnim tačkama/Anchors oko uglova. 
To vam omogućuje da promenite veličinu klikom i povlačenjem bilo koje fiksne tačke. 
Kako želimo da budemo precizniji, koristićemo svojstva-Properties na vrhu

INDESIGN 1 
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W10
INDESIGN 1 

CREATING MULTI-PAGE DOCUMENT, 
BLEED ADJUSTMENT, 
MASTER PAGE - OBJAŠNJENJA

Kreirajmo dve stranice. Jednu kao prednju, drugu kao zadnju stranicu vizit-kartice. 
Za početak, umesto unosa širine/visine, selektovaćemo Customdrop down i US 
Business Card. 
Sada u InDesign-u imate  dokument koji ima četiri strane različitih dimenzija. Jednu 
za pismo, jednu za kovertu i dve za vizit-karticu. Ukoliko odzumirate, primetićete da 
su dimenzije strana drugačije u Radnom prostoru od onih u Pages panel(panel sa 
prikazom stranica, desni prostor ekrana). 
Ovo vam pomaže da imate uvid u to na kojoj stranici radite, uvid u poglavlja,zaglavl-
ja, uopšte da imate jasniji pregled procesa vašeg rada. 

OBJAŠNjENjA MASTER PAGE-a:
Master Page je strana koja se
 ne štampa, a koju možete koristiti 
kao uzorak/šablon za ostale strane 
vašeg dokumenta. 

Master strana može sadržati tekst / neki 
grafički element koji će se pojavljivati na 
ostalim stranama (npr. u vidu poglavlja/
zaglavlja, numeracije strana itd.)
(headers, footers, page numbers..) 
Master strana je poput pozadine koju 
brzo možete primeniti na strane. Elemen-
ti sa Master strane pojaviće se na svim 
stranama ukoliko je ta Master strana 
označena/aktivna. Takođe, promene koje 
pravite na Master stranici, automatski se 
prenose na ostale strane i prikazuju na 
njima. //vežbe posebno za ovu temu
Master pages često sadrže logo-e koji se 
ponavljaju, brojeve strana(numeracija), 
poglavlja/zaglavlja i sl. Takođe, mogu 
sadržati i prazan okvir za tekst koji može 
služiti kao prostor za smeštanje.

R10CREATING MULTI-PAGE DOCUMENT 
BLEED ADJUSTMENT, 
MASTER PAGE - OBJAŠNJENJA

Bleed
Bleed je područje izvan okvira dokumenta koje se seče pri štampanju.                      
Smatra se merom predostrožnosti / sigurnosti kako bismo zaštitili naš
dokument od suvišnog belog prostora koji preostaje nakog sečenja.
Prilikom pripreme dokumenta za štampu, vrlo je važno da Bleed bude podešen 
tačno do ivica dokumenta i da je sadržaj dokumenta na bezbednoj udaljenosti od 
linije po kojoj se sečenje vrši.

Za novi dokument
File > New document > Bleed 3mm     OK

Potom, sledi:
File – Doc setup—Bleed option=visible—podesiti Bleed na 3mm

INDESIGN 1 

Ne zaboraviti potragu za 
resursima i linkovima!
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INDESIGN 1 

CREATING MULTI-PAGE DOKCUMENT, 
BLEED ADJUSTMENT, 
MASTER PAGE - OBJAŠNJENJA

Iako Bleed nije podešen:
Klik na W i crvene linije će se pojaviti 
u dokumentu
Proširiti do crvenih linija
File>Export>pdf (pdf /x-10;2008)

Pripazite i obratite pažnju na Bleed
opcije dok izvozite/eksportujete.
Hvala !

http://guides.lib.umich.edu/c.php?g=282834&p=1884599

Linkovi:

R11WORKING WITH IMAGES 
AND TEXT BOXES; 
IMPORTING DATA FROM 
ILLUSTRATOR

Vremenski okvir i Metode:
Pregled domaćih zadataka - 15min
Predavanje i demonstracija - 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični rad učesnika - 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice: 110min

Ciljevi:
Upoznavanje sa radom sa slikama i tekstom u InDesign-u,
uvozom podataka/dokumenata iz Illustrator-a.

PREDAVANjE:

INDESIGN 2 

Ne zaboraviti potragu za resursima i linkovima na ovu temu!

Najbrži način za uvoz slike u InDesign 
je primena Place komande
(File>Place).
Klikom (ctrl - d) možete pronaći sliku 
koju želite, koristeći Microsoft 
explorer.
Slika će biti smeštena tamo gde nam 
je strelica miša, kursor. Nešto što 
treba imati na umu pri radu sa 
slikama u InDesign-u jeste to da ovaj 
program koristi okvire za smeštanje 
slike u dve veličine, jedan za sliku u 
njenoj prvobitnoj veličini, a drugi za 
prikaz samo željenog dela slika. 
Ako koristimo desni klik miša, 
ponudiće nam se opcije 
(image alignment, effects, 
color modes) koje se odnose na okvir 
za prikaz slike-Image box.
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WORKING WITH IMAGES AND
TEXT BOXES,
IMPORTING DATA FROM 
ILLUSTRATOR

Tekst:
Text box(prostor u kome se tekst prikazuje) kreirati:
klikom na  Type Tool        , potom na radnoj površini vući stisnutim kli-
kom miša i jednostavno pustiti kada nam se pojavi odgovarajaći 
Text box (čiju veličinu možemo korigovati i kasnije)

Bitno je znati to da  veličina teksta ne zavisi od veličine Text box-a.

Možemo menjati veličinu teksta oprema našoj želji, kao i u programima o 
kojima smo prethodno govorili, ali za menjanje boje teksta potrebno je da koristimo 
Swatches, paletu za pozadinu teksta takođe.

Desnim klikom možemo videti listu opcija, poput - efects, alignments i slično. 
Važno je istaći i to da okvir za prikaz teksta možemo popuniti i nasumice odabranim 
tekstom, radi prezentacije koncepta ideja (npr. Lorem ipsum tekstovi online).

R11W11
UVOZ U INDESIGN IZ ILLUSTRATOR-a
Uz Place komandu možemo jednostavno uvesti dokument u 
InDesign iz Illustrator-a, međutim, uveženi dokument biće
 baziran na pikselima, ne na vektorima. Kada želimo da vektorski rad uvezemo iz 
Illustrator-a, potrebno ga je otvoriti upravo u Illustrator-u a kopirati (copy-paste) ga 
u InDesign, tada će rad/slika/dokument/ biti kopiran u InDesign u vektorima i moći 
će tako da se prikazuje.

http://www.dummies.com/software/adobe/indesign/create-text-frames-in-indesign-cs5/
https://www.youtube.com/watch?v=_TIV8fRsqyc

Linkovi:

WORKING WITH IMAGES
AND TEXT BOXES,
IMPORTING  DATA FROM
ILLUSTRATOR

INDESIGN 2 

Ne zaboraviti na potragu za resursima i linkovima na ovu temu!



41

B E H O L D 

STUDENTS ARE
BECOMING 
THE 
TEACHERS !

R12PAGE NUMERATION, 
MULTI-MASTER PAGES, 
EXPORTING DATA

Vremenski okvir i Metode:
Pregled domaćih zadataka - 15min
Predavanje, demonstracija - 30min
Online video/korak-po-korak tutorijal primeri - 10min
Praktični rad učesnika/Vežbe - 45min
Uputstva za naredni domaći zadatak - 10min
Očekivano trajanje radionice: 110min

Ciljevi:
Demonstracija i upoznavanje sa:
Numeracijom strana
Opcijama Multi-Master-a
Izvozom podataka/dokumenata // Eksportovanje - Export data

PREDAVANJE:

PAGE NUMERATION (NUMERACIJA STRANA):
Zajednički zadaci numeracije: dodavanje brojeva stranica dokumentima knjige, 
dodavanje broja nekoj sekciji i dodavanje brojeva poglavlja.
Vašim stranicama može se dodati marker/oznaku/simbol sa trenutnim brojem 
strane-Page number marker, kako biste odredili gde na njoj je broj smešten i kako 
izgleda.
Ažuriranje markera broja strane je automatsko, prema tome, broj koji je prikazan je 
uvek tačan - čak iako dodajete, uklanjate, ili reorganizujete strane u dokumentu. 
Ti markeri mogu se formatirati i slitilizovati kao tekst.
Dodavanje Page number marker za Master page:
Često se vrši dodavanje markera na Marker stranu. 
Kada su Master strane primenjene na dokument, numeracija strana se ažurira 
automatski, slično kao sa zaglavljima i podnožjima. 

Numeracija na Master A (levo) i strana 5 bazirana na istom Master-u (desno)

Ako je automatska numeracija 
aktivna na Master strani, 
prikazuje Prefix Master strane, 
i na stranici dokumenta, 
automatska numeracija 
omogućuje prikaz Broja stranice.

INDESIGN 3 
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Dodajemo broj na odabranu Master stranu duplim klikom na nju (na panelu sa 
prikazom stranica). 

Napraviti okvir za tekst dovoljno velik da u njega možete smestiti najduži broj strane kao 
i tekst koji želite uz njega. Odredite mesto okvira za tekst na kome želite da se broj vaše 
strane prikaže. Ukoliko je na vaš dokument primenjena opcija Facing pages, kreirajte 
odvojene okvire za tekst za levu i desnu Master stranu.
U okviru za tekst u kome upisujete broj strane, možete dodati i neki željeni tekst, iza ili 
ispred broja (na primer - Strana 9)
Kada odaberete poziciju na kojoj želite da se vaš broj pojavi, izaberite:
Type > Insert Special Character > Markers > Current Page Number.
Primenite Master stranu na strane dokumenta na kojima želite da broj bude prikazan.

R12PAGE NUMERATION, 
MULTI-MASTER PAGES, 
EXPORTING DATA

MULTI – MASTER STRANE
Master je poput pozadine koja se brzo može primeniti na više 
stranica.

Masteri, kao i strane vašeg dokumenta, mogu imati više lejera/slojeva.
Objekti jednog zasebnog lejera mogu imati sopstveni poredak slaganja 
unutar lejera. 
Objekti lejera Mastera pojavljuju se iza objekata koji su određeni za isti lejer strane 
dokumenta.

Ukoliko želite da se objekat sa Master 
strane pojavi ispred objekta sa 
dokument strane, objekat sa Mastera 
postavite na viši lejer. 
Taj objekat postavljen na viši lejer, 
pojavljivaće se ispred svih objekata 
smeštenih na nižim lejerima(lejerima 
ispod).
Spajanje svih lejera dovodi do postavke 
objekata Mastera ispod objekata strana 
dokumenta.

Objekti Mastera (gore levo) pojavljuju se iza objekata istog lejera strane dokumenta (dole 
levo) ; pomerajući objekat Mastera na viši lejer (gore desno), postavljamo ga ispred svih 
objekata koji pripadaju nižim lejerima(dole desno).
Kreiranje Master-a:
Uobičajeno, svaki dokument koji kreirate ima Master stranu.
Možete kreirati dodatne/naknadne Mastere ispočetka, ili iz postojeće Master strane ili 
strane dokumenta. Nakon primenjivanja Master stranica na ostale stranice, sve promene 
načinjene na izvornom/prvobitnom Masteru, prenosiće se na druge mastere i na strane 
dokumenta koje su bazirane na njemu. 
Uz pažljivo osmišljanje i planiranje idejnog rešenja, ovo pruža lak način za menjanje 
kompozicije, rasporeda detalja, preloma i primenu drugih željenih promena na više strana 
vašeg dokumenta. 

W12
INDESIGN 3 

Objekti sa onog Mastera koji je aktivan/odabran, prikazuju se na svim stranama 
dokumenta, i pri tome okruženi su tačkastom granicom. 
Takođe, sve promene koje vršite na Masteru automatski se prikazuju na svim ostalim 
povezanim stranama. Master strane uglavnom sadrže logo-e koji se ponavljaju, 
brojeve stranica, poglavlja, zaglavlja... Mogu sadržati i prazne okvire za tekst i grafike,
koji imaju svrhu prostora u koji želite nešto da smestite na stranama dokumenta. 
Važno je znati - objekat sa Master strane ne može biti selektovan na stranama 
dokumenta, izuzev onda kada je taj objekat preuređen za ponovno specifikovanje.
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https://www.youtube.com/watch?v=hM5eRzJfkCI

Linkovi:

Kreiranje mastera ispočetka:
Odabrati New Master u meniju Pages panel-a.

Odaberite sledeće opcije, potom klik na  OK:
Kao Prefix, uneti prefiks koji će identifikovati primenjeni Master za svaku stranu u Pages 
panelu. Mogu se uneti četiri podatka/karaktera. Pod Name uneti naziv osnovnog/glavnog 
Mastera.
Za Based On Master, izabrati postojeći osnovni raspon mastera, za koji želimo da bude baza 
novom Masteru, ili odabrati None. 
Za Number Of Pages, type a value for the number of pages you want in the master spread 

EXPORT TO ADOBE PDF (IZVOZ PODATAKA):
Izvesti/Eksportovati dokument kao Adobe PDF, ili postaviti PDF na internet, ili isko-
ristiti kao pripremni materijal za štampu. 
PDF za internet može sadržati interaktivne elemente, poput snimaka/filmskih zapi-
sa ili zvučnih zapisa, navigacijskih tastera - Buttons, prelaza/kretanja strana - Page 
transitions. 

R13W12 REZIME CELOG PROGRAMA 
I PONAVLJANJE PROPUŠTENIH 
TRENINGA

Vremenski okvir i Metode:
Pregled domaćih zadataka - 20min
Teorija i demonstracija sadržaja propuštenog- 40min
Online video/korak-po-korak tutorijal primeri - 20min
Vežbe učesnika - 40min
Očekivano trajanje radionice: 120min

Ciljevi:
Prolazak kroz propuštene radionice 
Evaluacioni upitnik  >> Odgovori
Osvrt na sva tri obrađivanja programa - beneficije, rezultati > zaključak

REZIME 

Potražiti nove 
resurse na 
temu !

https://www.youtube.com/watch?v=yAidvTKX6xM
https://www.youtube.com/watch?v=t9OTcdc2mwc

Linkovi:

Ne zaboraviti na potragu za resursima i linkovima !
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by Hudson-Powell 
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Tanja Mirković
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autor - Dijana Makijević



http://www.designyourjob.org/
                      2017

‘’Good design is all 
about making other 
designers feel like 
idiots 
because that idea 
wasn’t theirs’’
Frank Chimero

‘’ good design is as 
little design 
as possible ‘’ 

‘’..back to purity
..back to simplicity. ’’

d i e t e r    r a m s 

‘’very nice’’
MIHAEL NIKOLIC_Prince of 
Room no. 308

TANjA MIRKOVIC

BORIS NEGELI

T. MIRKOVIC

http://www.designyourjob.org/
                      2017

‘’Good design is all 
about making other 
designers feel like 
idiots 
because that idea 
wasn’t theirs’’
Frank Chimero

‘’ good design is as 
little design 
as possible ‘’ 

‘’..back to purity
..back to simplicity. ’’

d i e t e r    r a m s 

‘’very nice’’
MIHAEL NIKOLIC_Prince of 
Room no. 308

TANjA MIRKOVIC

BORIS NEGELI

T. MIRKOVIC

 sobe 308_


